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Whew! The manuscript is done, written, edited and polished. 

The file is ready to send to the printer to turn into tangible books. 

Now it’s time to turn that manuscript into an e-book. 

Once upon a time, books came in just two flavors: hardcover 

and softcover (paperback). The 21st Century has expanded the 

options available to readers, which in turn offers more ways for 

authors to put their writing in front of readers. According to the 

American Association of Publishers’ StatShot Annual for 2014 

(which reflects only the 1,200 largest publishers), book publishing 

is a $28 billion industry.  

Although total trade book sales fell somewhat in the first 

quarter of 2015 (most notably in children/young adult and 

religious presses), the 2014 book market for those 1200+ publishers 

looked like this: 

 Sales revenues Sales – units Growth from 

2013 

Total trade 

books 

$15.43B 2.42B 4.2% 

Hardback $5.99B 568M  

Paperback $4.84B 942M 9.5% 

e-Books $3.37B 510M 3.8% 

Audio books $305M 48M 26.8% 

 

Clearly, e-books contribute significantly to the major 

publishers’ revenues – about 22% of total revenues. But that’s not 

the whole story. Because the production and distribution costs are 

much less – nearly negligible – e-books are an important profit 

http://publishers.org/news/us-publishing-industry%E2%80%99s-annual-survey-reveals-28-billion-revenue-2014
http://publishers.org/news/aap-statshot-sales-slow-during-first-quarter-2015
http://publishers.org/news/aap-statshot-sales-slow-during-first-quarter-2015
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center.  That factor is even more essential to traditional publishers 

who are being squeezed by growing printing costs and hardball 

pricing strategies by mass market retailers. 

Taking a clue from the “big boys” of New York, independent 

publishers and authors have a low-cost method to increase their 

profit from their books by producing e-books in addition.  As the 

majors have proven, e-books can be profitable in their own right 

but they can also drive sales of tangible books. (But that’s 

marketing strategy, which will be ignored in this book.) 

StatShot 2014 reported that online retail continues to be the 

way Americans buy most books. About 832 books (from those 

1,200 publishers) were sold online last year, compared to 577 in 

brick-and-mortar stores.  While walk-in store book sales have 

been declining for years -- even with elephants like Wal-Mart and 

Costco as major players – online bookselling is great news for 

independent publishers. 

 Like e-books and print-on-demand technology, e-commerce is 

a relatively low cost avenue. That translates into greater 

profitability. Many experts have said that the technological 

advances of the last decade or two have “democracized” 

publishing unlike anything since Gutenberg’s printing press.  The 

economic barriers to publishing have crumbled, and along with 

them many of the business models that have dominated 

publishing for the last 200 years. 

Simply, publishing is now available to anyone with something 

to say.  

 

By the way, this book will refer to Microsoft Word because it is 

the most widely known word processing program. It is not the 

only word processor, and not necessarily the best. The best 
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software is what is most comfortable and transparent to the writer 

– the program shouldn’t get in the way of writing. 

In addition to Microsoft Word, other noteworthy word 

processors include: 

Word Perfect (has an E-book Publisher add-on) 

Libre Office (formerly Open Office) 

WPS Office (a.k.a. Kingsoft Office) 

SSuite Office 

AbiWord 

Jarte  

Angel Writer 

As if this list doesn’t offer enough choices, Writer’s Digest sells 

specialty writing software and TechRadar.com has a list of 10 free 

programs for writing fiction. 

http://www.wordperfect.com/us/
http://www.wordperfect.com/us/pages/items/12400017.html
http://www.libreoffice.org/
http://www.openoffice.org/
http://wps.com/wps-office-personal/
http://www.ssuitesoft.com/
http://www.abisource.com/
http://www.jarte.com/
http://www.angelicsoftware.com/en/angel-writer.html
http://www.writersdigestshop.com/browse-by-product/writing-software
http://www.techradar.com/us/news/software/applications/best-free-software-for-writing-10-programs-to-unleash-your-creativity-1141280
http://www.techradar.com/us/news/software/applications/best-free-software-for-writing-10-programs-to-unleash-your-creativity-1141280
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Most authors write with a physical book in mind, knowing 

that the publisher will format the text for the book’s layout.  E-

books demand a different mindset and some extra steps to make 

the manuscript ready for e-book production. 

Word processing software (as opposed to plain text editors 

like Notepad) handle formatting tasks with hidden tags 

embedded into the document.  After countless rounds of editing, 

these marks can become a hodge-podge, unseen on the screen or 

paper. Print publishers will scrub the manuscript through their 

own software when they do the page layout, so these tags don’t 

matter to them, either. 

For an e-book, they can create havoc. The first step in 

producing an e-book is to clean up those hidden formatting 

marks. 

A writer can see the formatting marks in Microsoft Word by 

going to the Paragraph group in the Home tab and clicking on the 

paragraph mark (¶). However, that may not reveal all of the 

hidden marks.  To change the settings, click on the File Tab (round 

Office button in word 2013), then Word Options, then Display, 

then Show All Formatting Marks. 

You may be surprised at how much is going on behind the 

scenes. If you have written a novel or some other kind of book 

that is essentially all text (without graphics or references), a good 

https://support.office.com/en-us/article/Show-or-hide-formatting-marks-C0460106-19D3-4441-986C-B655BFFE6BE4
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first step is to save your finished manuscript as a text file. Go to 

File, then Save As and in the Save As Type box, select “Plain text 

(*.txt).” This step will strip out all of the formatting commands, 

giving you a clean slate to format your narrative for an e-book. 

Next, open your plain text version in your trusty word 

processor and do some technical clean-up. (It wouldn’t hurt to do 

these chores before shipping your manuscript off to the print 

editor, either.) 

If you aren’t already a master of Find & Replace, you will be in 

a few minutes.  Pressing Ctrl-F brings up the Find function, but 

Word also offers a shortcut for Find & Replace, Ctrl-H.   

Use Find to check your quotation marks. Make sure all open 

quotes are paired with close quotes, and that you’ve used double 

quotes instead of single quotes (unless, of course, you’ve got 

quotes within quotes). 

Next, use Find & Replace to check for: 

Spaces between sentences. Double spaces were taught in 

typing classes until the advent of the word processor, but the style 

has changed to single spaces now. Check whether some double 

spaces have crept into your writing. 

Dashes. Word by default takes two hyphens surrounded by 

single spaces and translates them into “em dashes.” An em dash is 

a long dash (the width of an M). An en (short) dash looks like a 

hyphen. A double space before or after your hyphen pair may 

leave you with two hyphens instead of the professional looking 

em dash. 

Indents before paragraphs. Remove any tabs or spaces you 

used to indent paragraphs. You’ll set those indents with styles in a 

minute. 
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Formatting with styles 

Most e-book formats are adaptations of HTML, the language 

of websites (more on that shortly). HTML uses “styles” to format 

blocks of text, so to make the manuscript ready to become an e-

book, the manuscript needs to be formatted with styles.  

Fortunately, Word and other powerful word processors also 

use styles. You may not have realized it, but anytime you write 

something in Word, you are applying styles to your text. The 

default is the “Normal” style, highlighted on the Home tab 

ribbon. 

For a typical book, only two or three styles are needed. It’s 

simply a matter of customizing the defaults to what you want. 

Start with the Normal style, which will define your body text: 

1. Place the cursor in a paragraph, so the Normal style is 

highlighted (boxed) on the ribbon. 

2. Right-click on the Normal style box to display a popup 

menu. 

3. Click Modify. 

4. Change the font, size, spacing and other aspects to your 

desired look. (Word’s default is 11pt Calibri, 115% line 

spacing, 10pt space after paragraphs.) 

5. Set an indent for the first line of a paragraph by clicking on 

the Format button and selecting Paragraph. In the 

Indentation section, change Special to First Line. Default is 

first line indent of a half inch, but for the smaller size of 

books, you may want to reduce this to 0.25 inch. 

6. Click OK to finish the paragraph format changes, and then 

OK again to save the Modify Style changes. 
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7. Right-click the Normal style box again, and click on Select 

All to highlight the entire manuscript. Left-click on the 

Normal style to apply it to the full document. 

 
With the Normal style set, now do the Modify Style process 

again to change the Heading 1 style. This is the one to use for 

chapter titles, and breaks can be set so each chapter will start on a 

new page. 

1. Place the cursor in a chapter title line and then left-click on 

Heading 1 on the ribbon. 

2. Right-click on the Heading 1 style box to display a popup 

menu. 

3. Click Modify. 

4. Change the font, size, spacing and other aspects to your 

desired look. (Word’s default is 14pt Cambria, 24pt space 

before heading.) 

5. Click on the Format button and selecting Paragraph. 

6. Click on the Line and Page Breaks tab. 

7. Place a check mark by “Page break before.” In addition to 

setting the look of the chapter heading, this option will 

automatically move every chapter to a new page. 
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8. Click OK to leave the paragraph format popup, and then 

OK again to save the Modify Style changes. 

 
You may also want to set Heading 2 or Subtitle to your desired 

font if you will have subtitles within chapters. 

Now that Heading 1 is set and applied to your manuscript, 

jump back to the top of the file and create a table of contents: 

1. With the cursor before the beginning of the text, click on 

the References tab on Word’s ribbon. 

2. Click on the Table of Contents icon at the left side of the 

ribbon. 

3. Click on “Insert Table of Contents” near the bottom of the 

menu, not on one of the predefined automatic formats. 

4. In the popup box, uncheck “Show page numbers” and 

make sure “Use hyperlinks instead of page numbers” is 

checked. 

5. Click OK to save and generate the table of contents. 

Word’s automatic table of contents formats all include page 

numbers. Because e-book pages will change (“reflow”) to fit the 

reader’s screen size, page numbers won’t be accurate. Instead, 
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links to the chapters will let e-book readers jump to where they 

want to read. 
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Word has some graphic functions that might tempt you to 

prepare your cover as part of your manuscript file. Don’t do it! 

Graphic designs are much better handled through a graphic editor 

program, plus you will want the cover graphic separate for 

Calibre, Smashwords and Amazon KDP as well as for publicity. 

A standard softcover size is 6x9 inches. In graphics speak, 

that’s an aspect ratio of 1.5 – the height is 1.5 times the width. 

Amazon KDP uses a slightly different aspect ratio, 1.6, based on a 

5x8” page size. The aspect ratio may not seem important if the 

manuscript in intended to be an e-book, but is if you want to sell 

the book through an online retailer such as Amazon or if you later 

decide to print some copies through CreateSpace, Blurb, Lulu or 

another book printer. 

If you choose to go to your neighborhood quick print shop 

and produce a book with 5.5x8.5” pages, that’s an aspect ratio of 

1.55. Don’t fret that you need multiple layouts for your cover. A 

1.5 aspect ratio cover design fitted into Amazon’s 1.6 space would 

have an extra quarter inch of space top and bottom. Simply keep 

this in mind as you are laying out your cover. 

Assuming this book is a complete do-it-yourself project and 

you aren’t hiring a cover designer, you’ll need a graphic editing 

program. Pricey Adobe Photoshop may be the one that first rolls 

off many authors’ tongues, but it’s not the only player. Among 

other choices: 

 Corel Paintshop Pro – powerful, commercial graphics 

editor. 

https://www.createspace.com/
http://www.blurb.com/
https://www.lulu.com/
http://www.photoshop.com/
http://www.paintshoppro.com/en/
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 GIMP – Leading open source (free) competitor to 

Photoshop. Powerful, but steep learning curve. 

 Paint.NET – also free and powerful. Needs Microsoft’s 

.NET software installed to run. 

 PhotoScape – free and easy to use 

 Zoner Photo Studio – also free and easy to use 

 Google Picassa – remarkable versatile despite being 

oriented to posting pictures online 

The first step in any graphic editor is to set up the “canvas” 

(page) size. Amazon’s Kindle Direct Publishing stipulates that 

cover image dimensions must be at least 625x1000 pixels, with a 

recommended size of 2,500 pixels on the long side (that would be 

1563x2500 pixels for the 1.6 aspect ratio). 

A pixel in simplest terms is a dot – a dot on the monitor screen 

or a dot in a printed halftone image.  E-book readers range from 

fairly low resolution of 600x800 pixels on early e-book readers to 

1080x1920 high-definition (HD) resolution on the latest Kindle 

Fire HD and some tablets. Meanwhile, a print-on-demand (POD) 

press typically will print at 300 dots per inch, so a 5x8” cover 

would translate to 1500x2400 pixels for its artwork. 

For a canvas size, set 1500x2400 (or 1600x2400 if you want to 

work with a 1.5 aspect ratio). If you are sure your design will 

never go to print, you could use 750x1200 pixels. With “bitmap” 

(dot-by-dot) images, reducing their size doesn’t hurt quality while 

they will get jagged when enlarged. 

A cover should be simple and uncluttered but include 3 

elements: 

1. Title of book 

2. Name of author 

3. Image (either photo or illustration) 

http://www.gimp.org/
http://www.getpaint.net/index.html
http://www.photoscape.org/ps/main/index.php
https://free.zoner.com/
http://picasa.google.com/
https://kdp.amazon.com/help?topicId=A2J0TRG6OPX0VM
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A nonfiction book also routinely has a subtitle. 

Start with the image, which will serve as the background, and 

then place type in layers over the image. 

Be respectful about copyrighted images and don’t use without 

permission and probably payment. Stock image suppliers make it 

easy to find a photo or illustration that fits your theme and 

purchase a license for a modest price.  

Authors on really tight budgets should look for images with 

Creative Commons licenses.  In between “all rights reserved” 

copyrights and “free for everybody” public domain, Creative 

Commons is a set of six alternative licenses where the creator 

retains ownership but permits use of the work without payment.  

Generally, a Creative Commons (CC) license requires the creator’s 

name be displayed (“attribution”). Many top and aspiring 

photographers and illustrators place CC licenses on some images 

to draw attention to their stock images and possible assignments – 

sort of a portfolio of good but not best work. 

Numerous websites provide Creative Commons licensed 

images. The most extensive collection is on Flicker, where 

approximately 350 million photos are available under Creative 

Commons. The Creative Commons organization also has a search 

function to fix CC licensed images throughout the Internet. Bing’s 

image search allows users to specify “Free to share and use 

commercially” as a search filter.  

Amazon accepts both JPEG (JPG) and TIFF image formats.  

JPEG loses detail each time it is saved, so during editing save your 

images as TIFF, PNG or BMP where all the detail is preserved. 

JPEG has the advantage of being smaller files than lossless 

formats, so save only the final version for publication as a JPEG 

http://creativecommons.org/
https://www.flickr.com/creativecommons
https://www.flickr.com/creativecommons
https://www.flickr.com/creativecommons
http://www.bing.com/images
http://www.bing.com/images
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(in addition to a copy in lossless format, in case you need to edit 

again later). 
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Finally the manuscript is ready to put into e-book format. But 

which one? 

Literally dozens of e-book formats have been developed over 

the last few decades. However, there are only three to pay 

attention to, and two more worth mentioning. 

PDF (Portable Document Format) 

Adobe developed PDF as a proprietary format for printing 

documents so they would look the same regardless of the 

computer, software and printer used to create and print them.  It 

is ideal for books with extensive graphics and complicated 

layouts, because the book will look just like how the publisher 

designed it. Because the layout is fixed, however, it reduces 

proportionately on small devices so that it can be hard to read on 

a smartphone. 

Adobe released the PDF format as open source in 2008, so now 

more than 3,000 products work with PDF. Adobe has since 

developed a supplemental Digital Rights Management (DRM) 

system which provides copy protection to PDF documents. DRM 
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is essential for enlisting commercial content producers to back 

PDF. They know they can restrict viewing and printing of PDF 

documents so they don’t lose money to bootleg copying. DRM-

enabled PDF files require Acrobat Digital Editions or similar 

software rather than the basic Acrobat Reader. 

PDF books can be created directly from Word through the 

Save As function, making PDF the easiest e-book format to 

prepare. 

MOBI and AZW 

MOBI and EPUB differ significantly from PDF in that both are 

based on HTML, the language of the web, and CSS (Cascading 

Stylesheets, an extension of HTML). The HTML foundation allows 

these two formats to be “reflowable” – change layout to fit the 

reader’s screen.  Because portable e-book readers and 

smartphones have smaller screens than desktop computer 

monitors, this so-called responsive nature makes MOBI and EPUB 

equally readable on any device.  

Since buying the French company in 2005 that developed the 

Mobipocket e-book format, Amazon has built proprietary formats 

AZW and the current Kindle Format 8 (KF8, or AZW3, developed 

for the Kindle Fire) based on MOBI. MOBI files can be read by all 

Kindle readers so they are the format for publishers who want to 

provide books to Kindle owners. 

AZW files are produced and sold only by Amazon, but 

Amazon’s KindleGen software can convert HTML and EPUB files 

into a single Kindle file supporting both MOBI and KF8. Amazon 

requires that any books converted with KindleGen be sold only 

through the Kindle store (although free e-books may be 

distributed through other outlets such as your website). 

http://www.adobe.com/solutions/ebook/digital-editions.html
http://www.amazon.com/gp/feature.html/ref=amb_link_359603402_1?ie=UTF8&docId=1000729511&pf_rd_m=ATVPDKIKX0DER&pf_rd_s=right-4&pf_rd_r=18NS500R5VABAB8XYCB8&pf_rd_t=1401&pf_rd_p=2022792402&pf_rd_i=1000765211
http://www.amazon.com/kindleformat/kindlegen
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As an older standard, MOBI generally supports HTML4 while 

KF8 uses the newer HTML5 capabilities, including some video 

and audio. MOBI files can be either encrypted (DRM protected) or 

unprotected. 

Amazon has come under fire because there is a lack of e-book 

reader privacy with the Kindle.  Kindles report to Amazon the 

reader’s identity, what the user is reading, what page the user is 

on, how long the user has spent on each page,  which passages the 

user may have highlighted and whether the user has finished the 

book. Readers and publishers concerned with privacy have turned 

to the EPUB format as an alternative. 

EPUB 

Kindle readers do not handle EPUB books, but most other 

readers (Nook, Sony, etc.) use EPUB as their primary format. 

Unlike Amazon’s proprietary MOBI/AZW/KF8 format, EPUB is a 

free and open-source standard backed by the International Digital 

Publishing Forum. As open source, EPUB has no restrictions on its 

production or distribution. 

Like MOBI, EPUB is reflowable, is based on HTML and CSS, 

handles some video and audio content, and supports digital rights 

management. 

iBooks 

Thanks to websites, readers have gotten used to interacting 

with their content, choosing which content to read and in the 

order they choose, and then having the content respond to their 

choices. E-books have been weak in the interactive area because 

they have followed the printed book model. Leave it to Apple to 

come out with an alternative. 

http://www.amazon.com/gp/feature.html/ref=amb_link_357613502_9?ie=UTF8&docId=1000729901&pf_rd_m=ATVPDKIKX0DER&pf_rd_s=right-4&pf_rd_r=0RZQQ9CXP0GJQ2XHZ538&pf_rd_t=1401&pf_rd_p=2022788702&pf_rd_i=1000729511
http://idpf.org/
http://idpf.org/
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The iBooks format is noteworthy because of its capabilities 

and its backing from Apple. Nevertheless, it is a niche product 

which can be produced only by Apple’s iBooks Author program 

running on a Mac computer, and viewable only on an iPad or 

Mac. iBooks can be sold only through Apple’s iBooks store. 

The forward-looking nature of iBooks gives publishers a view 

of where e-books may go in the future. Apple has promoted the 

iBooks format to the textbook field, where the interactive features 

allow a end-of-chapter quiz to be answered and graded in the 

book. iBooks have strong multimedia capabilities. And iBooks 

offer a unique solution to the fixed PDF or reflowable 

EPUB/MOBI choice. When an iPad is held horizontally 

(landscape), the iBooks layout is fixed like a PDF. Turn it 

vertically (portrait orientation) and the book becomes reflowable. 

FB2 (FictionBook) 

The open-source, Russian-developed FictionBook format has 

been around since 2004 but is growing slowly in popularity.  It 

does not support digital rights management of any kind, limiting 

its adoption by commercial publishers. 

FictionBook is optimized for narrative literature and does not 

handle embedded images well. It is based on XML, a language 

similar to HTML but more stringent.  While a number of 

European brands of e-book readers accept FB2 files, Kindle, Nook 

and Sony readers do not recognize FictionBook so its use is 

limited in the U.S.  For tablets and computers, several FB2 reader 

programs are available, including FBReader, Anant Reader and 

Cool Reader. 

 

http://www.apple.com/ibooks-author/
https://www.apple.com/ibooks/
https://fbreader.org/
http://www.techfied.com/solutions/t-reader-for-ebook-readers-and-publishers
http://sourceforge.net/projects/crengine/
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For many novels, EPUB and MOBI may be all you need. Add 

PDF if you anticipate a significant number of readers will view the 

book on a computer. 
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Amazon’s Kindle Direct Publishing  and Smashwords will 

take Word DOC or DOCX files and make e-books from them, as 

will CreateSpace for printed books (although CreateSpace prefers 

PDF’s since pages can shift in DOC files).  That’s nice, but if you 

want to produce e-books to sell on your own website you’ll need 

to do one more step. 

If you have Word Perfect, you can prepare EPUB and MOBI 

files directly within the word processor. For everybody else, the 

solution is to download a free program called calibre (sometimes 

pronounced “kay-lee-brah” to emphasize its free nature, and 

always spelled without capitalization). 

Calibre is really the Swiss Army Knife of e-book tools. In 

addition to converting among various e-book file formats, it also is 

a library management system, managing a reader’s collection of e-

books. Plus, calibre is an e-book viewer for a variety of formats, an 

e-book editor and a tool to sync e-book devices, and a few other 

interesting capabilities. For those who prefer not to clutter their 

computers with more programs, calibre also has a portable 

version that can run from a flash drive without installing. 

Because EPUB and MOBI formats both are based on HTML, 

earlier versions of calibre required that you save the Word file to 

HTML. That’s easy … use the Save As command and choose the 

file type as Web Page, Filtered (htm, html). The filtered version 

strips out Word’s peculiar hidden code to generate a moderately 

clean HTML file. 

https://kdp.amazon.com/
http://www.smashwords.com/about/how_to_publish_on_smashwords
https://www.createspace.com/
http://www.calibre-ebook.com/
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The latest versions of calibre accept DOC and DOCX files (as 

well as RTF, Rich Text Format, a simpler format) for direct input. 

If you have specific elements that you want to control in the file, 

you would be better off using HTML but most publishers will 

discover that calibre handles a DOCX file just fine. 

Here’s where the Heading 1 style you modified for the chapter 

titles really come into play. Not only will calibre follow the 

instructions to start each chapter on a separate page, but it will 

also automatically compile those chapter titles into a table of 

contents. 

The calibre interface can be a bit daunting at first because 

there are so many options. Don’t worry, calibre’s defaults mean 

you don’t really have to set anything before producing your book. 

Also, some of the calibre website’s tutorials lag behind the current 

version of the software, so the steps are: 

1. On calibre’s main screen, which lists books in your library, 

start by clicking the Add Books button at upper left. 

2. In the browse window, navigate to the folder where your 

manuscript is 

3. Click on your DOCX file and then on the Open button to 

add it to your library. 

4. Back at the main screen, select your manuscript in the 

library list and then click on the Convert Books icon on the 

menu bar. 

5. Browse for your cover image (calibre will apply a basic 

cover if you don’t select something). 

6. Check and correct the title, author and tags in the boxes to 

the right. 

7. Select the output format in the box at the top right. (EPUB 

is the default.) 
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8. Click the OK button to convert your manuscript. The time 

will depend on the length of your manuscript and the 

speed of your computer, but should be from a few seconds 

to a few minutes. 

9. Once the conversion is complete and the library screen is 

displayed again, you will see below the cover image that 

the format will say DOCX, EPUB. Click on EPUB to view 

your finished e-book. 

10. Click on Convert Books to repeat the process for MOBI or 

other formats you want to produce. 
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Now that you have e-books, the next step is to make them 

available to readers. There are several options, and you’ll 

probably want to pursue as many as time allows to build the 

broadest possible market for your book. 

Amazon Kindle Direct Publishing 

As the leading retailer, Amazon is the outlet that leaps to mind 

first for many authors. Amazon makes it easy to put your book 

onto the virtual bookshelf with three programs it offers: Kindle 

Direct Publishing (KDP) for Kindle e-books, CreateSpace for print 

books, and ACX for audiobooks. 

Focusing on e-books, KDP has several advantages: 

 It’s free to publish your book and place it in the Kindle 

Store. 

 Books benefit from Amazon’s global distribution and 

name recognition. 

 Royalties are 70% for e-books priced $2.99 to $9.99 sold to 

North America, Europe, India, Brazil and Japan. 

 Royalties are 35% for books sold elsewhere worldwide and 

for e-books priced 99¢ to $2.98 and $10 to $200. (See 

Amazon’s Pricing Page, List Price Requirements and Sales 

and Royalties FAQ for full details.) 

 Amazon provides extensive reports and promotional tools. 

There are some downsides with KDP as well: 

 Amazon’s inventory is so huge that your book will get lost 

without serious promotion 

http://www.amazonkdp.com/
http://www.amazonkdp.com/
https://www.createspace.com/
http://www.acx.com/
http://www.amazon.com/Kindle-eBooks/
http://www.amazon.com/Kindle-eBooks/
https://kdp.amazon.com/help?topicId=A29FL26OKE7R7B
https://kdp.amazon.com/help?topicId=A301WJ6XCJ8KW0
https://kdp.amazon.com/help?topicId=A30F3VI2TH1FR8
https://kdp.amazon.com/help?topicId=A30F3VI2TH1FR8
https://authorcentral.amazon.com/
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 KDP distributes only KF8 formats for Kindle readers, so 

you don’t reach the EPUB readers market. 

 To take advantage of Amazon promotions and free 

giveaways, you must join the KDP Select program and 

exclusively distribute the digital book through KDP for at 

least 90 days.  You are precluded from making your e-

book available on your website or blog or in another 

digital format (EPUB, PDF). 

Smashwords 

Amazon isn’t the only e-book venue in town, and some 

authors find other avenues offer them greater flexibility. 

Smashwords is the largest independent e-book distributor. 

Among its plusses: 

 Distributes both EPUB and MOBI formats. 

 Distributes to most top e-book sellers: Barnes & Noble, 

OverDrive, Kobo, Scribd, iBooks, Baker & Taylor Blio and 

more. 

 Distribution to libraries through OverDrive and Baker & 

Taylor. 

 85% royalty from Smashwords.com sales and 60% from 

other e-book retailers. 

 Create coupons for discounts and free downloads 

 Daily sales reports 

 Upload either a Word DOC formatted according to the 

Smashwords Style Guide,  or an EPUB file through 

Smashwords Direct. One upload will generate the both 

formats Smashwords will distribute. 

 Free ISBN option 

Downsides: 

https://kdp.amazon.com/select
http://www.smashwords.com/
http://www.smashwords.com/books/view/52
http://www.smashwords.com/swdirect
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 If you choose to have a free ISBN, Smashwords will be 

listed as the publisher in Bowker’s Books In Print catalog. 

 Copyright page must say Smashwords Edition or 

Published at Smashwords or Published by XYZ Press at 

Smashwords. 

 Lower royalties (60%) for sales through other e-tailers, 

where most readers buy their books. 

 No distribution to Amazon – you must do that yourself. 

Your own book webpage 

Let’s just assume that by the time your book is ready to go, 

you already have an established online presence – website, blog, 

social media, maybe even a podcast and some YouTube videos. 

Use those to build awareness of your book, but don’t expect them 

to sell it. For that, you need a book webpage. 

A book webpage is a single page devoted to your book, with 

ordering information and links to your other outlets (Amazon, 

Smashwords, etc.).  Actually, the book webpage might actually be 

several pages online, if you have supporting or bonus material 

you want to provide to readers. 

A book webpage can be a page in your website, but it should 

have an easy to find address (such as forrestdavis.com/e-book). If 

you want to pursue serious online promotion and search engine 

optimization, you may want to invest a few dollars for a domain 

name for your book. 

Your book’s webpage should include: 

 The book’s title (and subtitle, if it has one) 

 Author’s name 

 Cover photo (yes, even for an e-book, so it looks like a 

“real” book) 

http://www.bowker.com/products/Books-In--Print.html
http://forrestdavis.com/ebook/
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 Short description (could be the back cover blurb) 

 Table of contents 

 How to purchase 

While you certainly want to promote the online sellers 

carrying your e-book, you will keep more of the sale if you sell the 

book yourself on the webpage.  A number of online payment 

processing services are available; the most common one is Paypal. 

Paypal charges 2.9% of the sale price plus a transaction fee of 30¢, 

so for a $2.99 e-book, the Paypal fee would be $0.39. (Arizona also 

collects sales tax on digital media sold by Arizonans, which would 

add $0.17 to the price, and more paperwork for the publisher.) 
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